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DENISON
N This documentation includes a basic overview of iMovie as a part of the iLife ’11 

suite, and it includes instructions on using iMovie ’11 to create a video project from 
start to finish. 

 

Connecting Your Camcorder to the Computer 

Once you are satisfied with the footage you have recorded using a digital 
camcorder, you can edit it on your computer using iMovie ‘11. To 
upload your video footage into iMovie, you’ll need the necessary cabling 
to connect the camcorder to the computer. 
 
You will need a FireWire cable, with one end that connects to the 
FireWire port on the computer and another end that fits in the DV port 
on the camcorder, like the one pictured at right. 
 
Plug the DV end of the cable into the camcorder DV port. On the 
camcorder pictured, the DV port was under a protective cover along the 
side of the camera, though the location of the DV port may vary from 
camcorder to camcorder. 
 
Next, plug the FireWire end of the cable into the computer’s FireWire port. On the Mac pictured, the 
FireWire port was located on the back of the monitor, though on other computers a port may be on 
the front or back of the CPU. 
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Uploading Your Footage to iMove 

After connecting your camcorder to the computer, turn the camcorder on and set it to Play/VCR 
mode. Then launch iMove by clicking the application icon on the dock or the Application 
folder. If an Import window doesn’t open automatically, you can open the File menu and 
choose an import option. You can also click the camera button on the left side of the 

middle toolbar to open the Import window.  
 

There are two settings for importing video, Automatic and Manual. Automatic is best when you would 
like to import all of the contents of the tape. When you choose Automatic, the program will 
automatically rewind the camera and start importing from the beginning. Manual is best when you 
would like to import a specific section of the tape. It allows you to navigate through your footage by 
rewinding and fast forwarding within iMovie so that you can choose where you would like to start and 
finish importing the footage. 

 
After selecting an import setting, click the Import button. 
 

Before the footage begins importing, a window will appear prompting you to save your movie. Select a 
location to save in the first drop-down option. Selecting the UserSpace will automatically save the file 
in the Movies folder in your personal user space on the hard drive of the computer on which you are 
working. (Never try to save to the Denison 
network; this will fail!) Next, name your 
movie in the Create new Event box. In the 
future, you will have the option of adding 
new footage to an existing event, but for 
your first import you must create a new 
event and name it. When you have finished, 
select OK to begin importing. 
 
When your footage has finished importing, 
click Done to stop importing. iMovie will 

the
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your footage and place them in the lower section of the screen as filmstrips.



INFORMATION TECHNOLOGY SERVICES 3  3 

iLife ’11—iMovie 
     

 

 

Reviewing Footage and Sequencing Your Clips 

To create a video project, select one of the locations 
within the Project Library (in the upper left corner of 
the window), open the File menu, and choose New 

Project. (You can also click the Add button 
in the lower right corner of the Project 
Library.) This will open the New Project 

window, allowing you to choose a theme for your 
video, name the project, and adjust other settings. 
When the project is configured as you like, click 
Create. The Edit Project window will then open in 
place of the Project Library. 
 
To preview the footage that you have imported, simply 
drag your mouse over the clips and a red play head will 
appear indicating your location in the clip. Run your 
mouse back and forth to skim the footage in the Viewer 
(the window in the upper right corner of the screen) or 

place your mouse 
where you would like to begin viewing and hit the spacebar. 
The video will then play at normal speed, and you can hit the 
spacebar again to stop. 
 
When you have viewed 

your footage and would like to create your project, you must 
begin by selecting which footage you would like to include in 
the final project. Clicking on a section of the footage will mark 
it with a yellow box. Once the video is selected, you can drag the left and right edges of this box to 
include all of the footage you would like to move to your final project. Use the Viewer to see exactly 
where you are placing the edges of the yellow box. 
 
Once you have highlighted the footage you wish to move to your final project just click, drag, and drop 
the clip into the project window above the filmstrips. Continue highlighting and dragging clips to 
create your project. 

 
You can also move footage into your project by clicking the Quick Select button and highlighting the 
clips that you would like to use in your final project. Once highlighted, the clips will 
automatically move to the end of your project, and you can then use the editing tools to 
trim the ends of the clips and make sure they line up correctly.

Tip: If you would like to skim your 
video without listening to the audio 
of the clips, you can turn the sound 
on and off with the audio skimming 
button. 
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Editing and Manipulating Video Clips 

Once you have added all of the clips you would like to include in your project, you can edit and refine 
your selections.  

 
To rearrange clips, click and drag a clip to a new location. Before you drop the 
clip, a green bar will appear to show exactly where the clip will be placed. 
 
To trim a clip and eliminate any unwanted video, select the clip and drag the 
right and left edges of the yellow box outlining it, placing the start and end bars 
exactly where you would like the clip to begin and end. When you are happy 
with the clip, open the Clip menu and choose Trim to Selection. This will delete 
all footage from the clip that is not inside the yellow 
box. 
 
If you need to trim your video more precisely, 
click on the blue Action button in the bottom 
left corner of a clip to open a pop-up 
menu that allows you to edit more 

precisely. 
 
The top two options, Precision Editor and Clip Trimmer, allow you to 
fine-tune your video clips. Choosing Precision Editor will open the Precision Editor window, 
allowing you to edit the transition between clips. The blue transitional bar in the middle of the 
Precision Editor window marks the division between the two clips. You can drag it so that one clip 
cuts the other at just the right moment. You can also adjust the sound of the clips by selecting the 
Audio button. By dragging the audio clips around you can use the audio from one clip 
with the video from another. Click Done when you are finished with the Precision 
Editor. 
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Choosing Clip Trimmer will allow you to closely trim the ends of a clip. After selecting it, the Clip 
Trimmer window will open, and you will be able to drag the edges of the yellow box to include the 
exact section of the clip you would like to use. 
 
The Action pop-up menu also presents three adjustment options, including Clip 
Adjustments, Video Adjustments, and Audio Adjustments. When you select 
any of these options, the Inspector window will open. This window allows you 
to adjust different aspects of your clip, including the color of the video, and 
sound, as well as adding visual effects to your clips. Use the tabs along the top 
of the Inspector to navigate the different tools offered. 
 
The Video Adjustment option allows you to alter the color and light in a clip or 
photo. It may be best to try different options to see what you prefer. iMovie 
makes it easy to undo your changes by choosing Revert to Original in the 
bottom left corner of the window. This will undo any changes you have made so 

you can feel free to try different effects without permanently changing your video 
clip. 
 
Under the Clip tab, you can choose different effects to apply to your video by 
clicking on the button next to Video Effect (by default, it will say None). The 
Inspector will then display various effects from which you can choose. You can also 
stabilize your video using the Clip tab if it appears shaky. To do this, check the box 
next to the Stabilization: Smooth clip motion option, and iMovie will work to 

smooth your clip. Depending on the length of your clip, this may take a long time. To apply a fast-
forwarding or slow-motion effect, click and move the Speed slider. Moving it to the left (toward the 
turtle) will slow the clip and to the right (toward the rabbit) will speed it up. You can also check the 
Direction: Reverse box below the speed slider to 
put the clip in reverse.  
 
You also have the option to crop an unwanted section from your clip. To do this, select Cropping & 
Rotation in the Action pop-up menu that appears by clicking the Action button. (Clicking the Crop 
button under the Viewer will also open the cropping options. A green box will appear around your 
clip, allowing you to drag its edges to include what you would like to appear in the movie. Choosing 
Fit in the upper left corner will include the entire frame. When you are finished, select Done.
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Enhancing Your Movie 

You can use iMovie to add audio, still images, titles, transitions, and 
maps to your video project. First, click on the icon in the media bar 
that corresponds to the element you would like to add. 

  
For advanced editing options, open the iMovie menu and choose 
Preferences. Within the General tab, check the box next to 
Show Advanced Tools. For information about using these tools, 
please refer to the separate documentation for the iMovie ’11 
Advanced Tools at 
http://www.denison.edu/offices/computing/support/training/d
ocumentation.html. 
 

Adding Audio 

To add audio, first click the Audio button located in the media bar. This will open the 
Music and Sound Effects sidebar. You can then use included sound effects or you can 
import audio from GarageBand or iTunes to create a soundtrack. 

 
To preview an audio clip, you can double-click its title or simply 
select a clip and click the Play button. When you have chosen an 
audio clip to attach to a specific video clip, select and drag it into 
the project window over the clip. The red play head will appear 
over your video to indicate where you are about to place the audio, 
and a green bar will appear under your footage to indicate the 
location and duration of the 
added audio file. 

 
To add 

audio as background to your clips, 
drag a clip into the project window without hovering over a video clip. 
The background will turn green to let you know that the clip is in the 
background.  
 
To adjust audio clips included in your video project, click the 
green audio button on the left edge of the audio clip. Shorten 
audio clips by choosing Clip Trimmer and dragging the 
edges of the yellow box to include only the audio you wish to 
keep. 

 
Double-clicking the audio clip in 
the Project Window will open the 
Inspector. Within the Inspector. 
you can adjust the volume of the audio clip to fade in and out or balance the volume of the audio with 
that of the video clip. You can continue to move the volume around until you achieve the desired 
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balance. Clicking the checkbox next to Ducking will allow you to turn the volume down on other 
tracks to highlight the audio on your selected track. 
 

To extract audio from an entire clip, select the clip from which you wish to 
remove audio. Open the Clip menu and choose Detach Audio. Now, the 
audio will appear as a purple line under the clip and you are free to move 
and edit it separately. 
 

To take audio from a portion of a clip, hold down the [Command ⌘] and [Shift] 
keys and drag the audio clip over the video clip that you want the audio to be applied 
to. When you drop the clip, it will then be linked with the new video clip. You can 
then select, move, and edit the audio clip. 
 

You can record your own 
voice to play over top of your footage by 

Voiceover button, found in clicking on the 
the center of the menu bar, and the Voiceover window 
will open. Choose the appropriate settings, including 
whether you are recording from a built-in or external 
microphone and the noise reduction necessary, based on 
background noise that you are recording over. 
 
When you have chosen the proper settings in the 
Voiceover window, click on the spot in your footage 
where you would like to begin recording. A countdown will appear in the Viewer window to indicate 

the beginning of the recording. Speak clearly into 
the microphone, and while you record, a red tint 
will cover the footage on which you are recording. 
When you are finished, click on the video clip 
again to stop recording.  
 
After recording, a purple line will appear under 

your footage to show the exact location and duration of your voiceover. If you need to, you can now 
move your voiceover recording by sliding the purple line to its exact 
location. 
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Adding Pictures 

To add pictures to your iMovie project, click on the Photos icon in the menu bar. This will 
open the Media Browser, which allows you to import from your iPhoto library. 

 
Some file types will not be recognized by iMovie. It is best to use 
JPEG or TIFF images. If you have photos that are not in JPEG or 
TIFF format, you can convert files using Adobe Photoshop or 
another image editing program. 
 
To bring a photo into your movie, click on the 
image you would like to insert and a blue box will 
outline the photo. The photo will also be displayed 
in the Viewer window. Click and drag the photo 
into your iMovie project. A green bar will appear 
to indicate where you are about to place the photo. 

 
Once you have inserted photos into your iMovie project, you can now edit them like all of your other 
clips. Click the Action button in the lower left corner of the picture and you will see different editing 
options available to you. 
 
By choosing Clip Adjustments, you can adjust the duration of 
photos in a video using the Inspector window. By default, 
photos added into iMovie are set to appear in the project for 4 
seconds. You can also apply video effects to your clip through 
the Inspector. 
 
The Action menu also includes the option Cropping, Ken Burns & Rotation. Select your photo and 

either double click on the small crop icon in the top left corner of the photo within the 
Project window or click on the Crop button in the menu bar. You will then be able to 
edit the photo in the Viewer window, using the buttons across the top of the window to 

apply different crop options to your photo. When you have finished modifying your photo, click Done 
in the upper right corner of the Viewer.
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Adding Titles 

You can add text and titles to your movie to add interest and clarify aspects of your 
video. Click on the Titles button in the media bar to open the menu. 

 
The Titles menu allows you to browse many different title 
options as well as choose a theme for the movie, which will 
automatically add titles and transitions to your project. To 
preview a title, hover your cursor over it. When you choose 
one that you like, select the title and drag it into the Project 
window. You can choose to place the title over top of your 
clips, at the beginning or end of your project, or between clips. 
If you drag a title over a clip, the footage behind it will have a 
blue tint; if you are dropping it between clips, a green line will 
appear to specify its location.  
 
When you let go, if you are 

adding the title where there is no video footage you will be prompted to 
choose a backdrop for your title, select one and it will be added to your 
project. To edit the title that you inserted, click on the blue bar to select 
it and edit it within the Viewer window 
 
You can adjust the font, color, size and alignment of the title by clicking 
the Show Fonts button in the upper-left 
corner of the Viewer. 
 
Click the Play button in the Viewer to preview your changes, or click 
Done when you are finished.
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Adding Transitions 

You can insert transitions into your iMovie project to ease the flow between scenes and 
give your project a more professional look. 
 
Click on Transitions button to open the Transitions menu. You can preview the different transitions 
by holding your mouse over their thumbnail images. When you have chosen the transition you would 
like to use, select its thumbnail, drag it into your project, and drop it between clips.  
 
If you would like to place a transition within a clip 
rather than in between two clips, you must first split 
the footage. Click on the clip to select it and adjust 
the yellow outline so that one edge is at the 
beginning or end of the clip and one end is placed 
where you would like the clip to split. Once it is 
adjusted, open the Clip menu and select Split Clip. 

 
You can now insert a transition within the clip by 
dragging it into the gap that you just created. 

 
To edit your 
transitions, 
first select the transition by clicking on it and click the Action 
button. From the menu that opens, you can choose to use the 
Precision Editor to select exactly where you would like your 
transition to occur or choose the Transition Adjustments 
option to open the Inspector window and adjust the duration 
of the transition or change the type of transition used. 
 

To modify the duration of all of your transitions uniformly, either mark 
the checkbox next to Applies to all transitions in the Inspector window 
or open the File menu and choose Project Properties and adjust 
Transition Duration there. When you are happy with your settings, click 
OK.

Note: The clip will split at both 
the beginning and end of the 
outline, so if you only want one 
division you must place either the 
left or the right edge of the 
yellow outline at the beginning or 
the end of the clip! 
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Adding Maps & Backgrounds 

iMovie includes the ability to add animated maps and globes to your project. This can 
provide interesting transitions in travel footage or in video projects in which you discuss 
different locations. To add a map or background to your project, click on the Maps, 
Backgrounds, and Animatics button in the Media bar. 
 
This will open the options seen at right. The top 
two rows of globes and maps can be animated to 
move from one location to another. The bottom 
row of stills cannot be animated, but simply appear 
like a photo that you can crop and adjust. Below 
this are various backgrounds that you can add to 
your project which also work like photos in your 
movie. 
 
Choose the map or background you would like to 
add, click the image thumbnail and drag it into 
your project. If you chose to add an animated map, 
it is important that you customize your map to 
show the correct locations. To do this, click on the 
Action button in the corner of the map in your 

project. Select Clip Adjustments from the 
menu that appears to open the Inspector 
window. 

 
In the Inspector window, you can change the 
duration of the clip, add a video effect, and 
customize the locations shown on the map or 
globe. Click on the Start Location, which 
defaults to San Francisco. This opens an 
alphabetical list of locations. Begin typing and 
the list will narrow. Choose the location you 
would like to enter. 

Note: Most small towns and suburbs will 
not appear as options in iMovie. Instead, 
choose the closest large city and change 
the name that is displayed on the map. To 
change the way it is displayed, type in the 
specific name you would like to appear in 
your project in the text box at the bottom 
of the window. 
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Exporting Your Final Movie 

Before sharing your final project, you can preview it in the viewer window by moving the play head to 
the beginning of the project and hitting the [Space] key or pressing the Play 
button under the Project window. You can also preview your project in full 
screen by clicking the Full-Screen Play button on the left edge of the Menu bar. 
 
At this point, your project is not in a format to share with others—it is a project file, not a finished 
movie file. You have several options to export your movie and share it with others. 
If you want to burn your movie onto a DVD using iDVD, open the Share menu and choose Media 
Browser This will open the publishing window where you can choose an appropriate size for your 
movie. The chart displayed makes size suggestions by placing dots to indicate the dimensions that will 
work best with the intended medium of your movie. When you have chosen the best size, click the 
Publish button; this will export your movie 
so that it will appear in the Media Browser 
of other iLife applications, including iDVD. 
You can now launch iDVD and begin 
creating your DVD project. (For more 
information on creating iDVD projects, 
please see Denison’s documentation on 
using iDVD.) 

 
If you would like to 
share your movie on a 
DVD but do not want to create a menu or chapters, you can select the DVD 
option from the Share menu, and your movie will be sent straight to iDVD 
where you can then burn it to a disk. There is no need to add a menu or titles; 
when you insert the finished DVD into a DVD player your movie will simply 
begin playing. 
 
If you wish to share your movie as a vodcast (a video podcast), open the Share 
menu and choose iTunes This will open the Publish window and prompt you to 

choose the best size for your project. After selecting a size based on iMovie’s suggestions, click the 
Publish button. Your movie will begin compressing, and when it is finished iTunes will automatically 
launch and your movie will appear in the application. 
 
To export your project as a movie file, open the Share menu and choose 
the Export Movie option. iMovie will then prompt you to save the project 
being exported and chose the best size. Choose a name and location for 
your movie. Do not save your movie file to a network drive. When you are 
ready, click Export to begin creating your movie. This may take a long time. 
When iMovie has finished creating your movie file, quit the application 
and locate your file. 

For more information on 
using iMovie, consult 
Apple’s documentation 
found in the Help menu. 


